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SAFETY 

Before Getting Started:  
Please read the entire manual before using the software. 

 

WARNING:  
Never pull or cut power to the loom without first shutting down the loom 
through the software.
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INTRODUCTION 

About AVL 

AVL Looms has been in the business of designing and building some of the 
world’s finest handweaving looms since 1977. 

Jim Ahrens had been building and designing looms for a number of years 
before Jon Violette, the “V” in AVL, approached Ahrens about a partnership 
in 1977.Violette, an industrial management professional, had discovered 
Ahrens’ work through his sister who ran the Pacific Basin School of Textiles 
in Berkeley, where Ahrens was a volunteer advisor. 

The two men worked together in the Bay Area for three years until Violette 
moved Ahrens and Violette Looms to Chico, where it officially became known 
as AVL Looms Inc., and has operated ever since. 

In 1982, Violette was instrumental in the development of the first 
computerized dobby, then called the “Apple Dobby”. He retired from active 
life in the company in 1987. 

Once known for our production looms, AVL has broadened its line 
considerably and we now offer customers a full spectrum of fine weaving 
equipment, ranging from our small Home Looms, to our Industrial Dobby 
Looms, Rug Looms, and Jacquards. 

The Compu-Dobby V Design Concept 

The guiding concept behind the Compu-Dobby V is ease of use with precise, 
repeatable control. The loom is designed to be easy to thread, easy to setup 
and easy to weave on. 

LOOM FEATURES 

Compu-Dobby® 

A first for handweaving looms, the Compu-Dobby 5 enables computer 
control of pattern and key loom functions, including warp tension and pick 
spacing. 

Pattern control is a state of the art system that eliminates the multi-treadle 
dance of traditional looms and the tedious pegging of mechanical dobby 
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looms. Much like the legacy cartridge systems from the Compu-Dobby I and 
II, the Compu-Dobby 5 stores entire weaving files (WIFs) onboard with three 
significant advantages over all other systems: 

 Ultra-fast pick writing. The system can achieve weaving speeds 
in excess of 100 picks per minute. 

 Hundreds of weaving files may be stored for later use. 

 Eliminates latency timing issues inherent in computer 
communications systems. Latencies can cause slower weaving 
and even missed picks. 

As a web enabled device, this loom connects to your computer or tablet via 
WiFi or USB and controls the loom from your favorite browser. AVLDrive 
version 5 is an easy to use, intuitive interface run from within the Compu-
Dobby 5. As a direct result, there is no software to install for the loom, nor 
limitation on the controlling device, except fora minimum screen resolution 
(1024 x 768 pixels). AVLDrive is compatible with all major browsers, including 
Safari, Chrome, Edge, Firefox and Opera. 

Warp Beams and Automatic Warp Tension System  

Another first in our industry, some looms offer digital control of warp tension 
using a small electrical motor and drive system connected via spring and 
brake cable to the warp beam. The motor is controlled by the Compu-Dobby 
& AVLDrive. Easily change the warp tension at any time during weaving by a 
click of the mouse or a touch of the finger on the touchscreen. This system 
allows very fine, repeatable control with a range from locked beam to free 
turning for winding on the warp. 

Automatic cloth advance is an AVL-only feature on hand weaving looms. 
Earlier mechanical versions of these systems are well known for providing 
fine control over pick advance spacing. This feature utilizes digital controls 
via an electric motor driven worm and gear attached directly to the cloth 
beam. Much like the digital warp tension controls, set the picks per inch in 
AVLDrive and start weaving. Easily change the advance setting or manually 
advance the cloth at any time during weaving by a click of the mouse or a 
touch of the finger on the touchscreen. This system allows very fine, 
repeatable control with a range from hundreds of picks per inch (or 
centimeter) to gross movements needed when starting a new warp.
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CONNECTING TO 
THE LOOM 

CONNECTING TO THE LOOM 

ATTENTION:  
Please read through this entire section before powering on your loom. 
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GETTING STARTED 

New Features: 

The loom uses a lighted interface for communication with the weaver. 

Light Name Description 
POWER Orange light means “power” to the loom in standby mode. 

Red light means “power” to the loom in weaving mode. 
NETWORK Different colors indicate the network status. 

Blinking Red: searching for LAN (Local Area Network). 
Red: connected to LAN 
Green: LoomDirect is available (not searching for LAN). 

COM Green light shows the loom is connected to a device. No light 
means there is no connection.  

ERROR Red light will shine when an error has occurred.  
SHED Red light will shine when shed is open. 
 

 

In order to connect to the loom, your device must either have a USB port or 
the ability to connect to the internet. There are three ways to connect a 
device to the loom: 

Connection Type Description 
USB  USB cable from your device to the loom. Only 

devices with USB ports can connect this way.  
LAN (Local Area 
Network) 

Through a router. Only devices with WiFi can 
connect this way. 

LoomDirect Connection to loom’s WiFi network (not through 
a router). Only devices with WiFi can connect 
this way. 
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The software interface (AVL Drive) is web browser based so you do not need 
to download anything. Simply open your standard web browser (Chrome, 
Safari, Firefox, etc.) and type in the loom’s address. 

Loom Modes 

The loom is designed to be controlled through the AVL Drive software, so 
there is no “power” button anywhere on the loom. 

In areas prone to brown/black out or power grid fluctuations, we recommend 
a 800W, 1000VA UPS for Compu-Dobby 5 equipped K-Series.In regions 
subject to lightning strikes and other extreme electrical anomaly incidences, 
we recommend the addition of a good surge protector between the outlet and 
UPS on the Compu-Dobby 5. 

STANDBY MODE: 

When you plug the loom in it enters Standby Mode. It is alright to leave the 
loom plugged in and in Standby Mode at all times. Minimal power is going to 
the loom, and some lights will be on, but the full power has not been turned 
on yet. In Standby Mode you’ll be able to connect to the loom via AVL Drive 
and power on the loom.  

WARNING:  
Never pull or cut power to the loom in STANDBY MODE. 

WEAVING MODE: 

Weaving mode is when the loom and all its digital controls have been 
powered on through AVL Drive. You will hear the warp tension motors set 
into place and other digital features come to life.  

WARNING:   
Never pull or cut power to the loom in WEAVING MODE.  

SHUTDOWN MODE: 

This mode allows you to shut down the loom properly so that power can be 
removed. It can be initiated from Weaving Mode or Standby Mode through 
AVL Drive. Shutting down the loom through AVL Drive is the proper way to 
stop all power to the loom.  

Once the loom has been shutdown the power cord can be unplugged. 

If the loom has been Shutdown through the software, but is still plugged in, 
simply unplugging it and plugging it back in will initiate Standby Mode.  

We’ll go into greater detail on all the modes in the following sections.  
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Powering on the loom:  

When powering on the loom for the first time, you will need to use either a 
USB connection or connect via LoomDirect. In order to connect via LAN, you 
will have to setup the Network information on the loom using one of the 
other connection types first. Once setup you can then connect via LAN each 
time you come to the loom. However, if Wifi connections are ever lost you 
can always revert to USB or LoomDirect. 

1) Connect the loom to power via the provided power cable. All lights 
but the “Error” light will light up as shown in the images below. 

 

2) Wait for the loom to bootup. This can take up to several minutes. 
Once ready the loom will show just the “Power” and “Network” 
lights. The network light may be Green or Red. 

 

SETTING UP COMMUNICATION 

Connecting via USB 

1) Plug the normal USB plug into your computer and plug the other 
end into the Compu-Dobby. 
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2) Open an Internet browser program on your computer (Chrome, 
Internet Explorer,

3) In the Address Bar, type in 
press Enter to open AVL Drive. 
when connecting via USB. 

Note:  
Any time you’re connected via USB you can use 
name to open AVL Drive.

4) When the connection is established, 
be green. 

Connecting via LoomDirect

LoomDirect means the loom is generating its own WiFi network and will 
show up as an available network on your device. The great part about this 
feature is that you don’t need
wirelessly connect to the loom. 
capability to connect to the internet.

The loom’s protocol is to first search for a LAN connection. If it does not find 
one, it will automatically switch to LoomDirect and create its own network.

Note: 
If no LAN connection is established your loom will automatically switch to 
LoomDirect.  

Dobby V User’s Manual Connecting to the Loom

 

Open an Internet browser program on your computer (Chrome, 
Internet Explorer, Microsoft Edge, Firefox, Opera, etc.).

In the Address Bar, type in 192.168.7.2 or the Loom Name
to open AVL Drive. This is the IP address for the loom 

when connecting via USB.  

Any time you’re connected via USB you can use the IP address or the loom 
to open AVL Drive. 

connection is established, the COM Light will turn 

 

LoomDirect 

LoomDirect means the loom is generating its own WiFi network and will 
show up as an available network on your device. The great part about this 
feature is that you don’t need to be actively connected to the internet to 

the loom. However, your computer must still have the 
capability to connect to the internet. 

The loom’s protocol is to first search for a LAN connection. If it does not find 
one, it will automatically switch to LoomDirect and create its own network.

f no LAN connection is established your loom will automatically switch to 
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Open an Internet browser program on your computer (Chrome, 
). 

or the Loom Name URL and 
s is the IP address for the loom 

the IP address or the loom 

 

COM Light will turn on and 

LoomDirect means the loom is generating its own WiFi network and will 
show up as an available network on your device. The great part about this 

internet to 
However, your computer must still have the 

The loom’s protocol is to first search for a LAN connection. If it does not find 
one, it will automatically switch to LoomDirect and create its own network. 

f no LAN connection is established your loom will automatically switch to 
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1) It can take up to several minutes for the loom to 
LoomDirect. 

2) When the Network light shines 
own network that can be fou

3) The network will be AVL_[loom_serial_number] where 
loom_serial_number is the serial number for your loom.

4) Connect your device (laptop, tablet, phone) to this WiFi network. 

5) The password for the network will be CompuDobby5.

6) The COM light will turn off while the loom is connecting. When the 
COM light turns green, you’ll know connection has been 
reestablished. 

7) Open your browser and type in 
loom if you’ve named it

 Compu-Dobby V User’s Manual
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It can take up to several minutes for the loom to switch to 

the Network light shines green, the loom is now putting off its 
own network that can be found from your device.  

The network will be AVL_[loom_serial_number] where 
loom_serial_number is the serial number for your loom.

Connect your device (laptop, tablet, phone) to this WiFi network. 

 

The password for the network will be CompuDobby5. 

light will turn off while the loom is connecting. When the 
COM light turns green, you’ll know connection has been 

Open your browser and type in 192.168.7.2, or the name of the 
loom if you’ve named it.  
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switch to 

loom is now putting off its 

The network will be AVL_[loom_serial_number] where 
loom_serial_number is the serial number for your loom. 

Connect your device (laptop, tablet, phone) to this WiFi network.  

light will turn off while the loom is connecting. When the 
COM light turns green, you’ll know connection has been 

, or the name of the 
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8) Once you establish the LoomDirect conne
through this process again. You can shut down your loom and you’ll 
be able to turn the loom on and connect to AVL Drive automatically. 

Note: 
If you switch to a new device, you will need to connect to LoomDirect 
new device and enter the Network ID and password.

Setting up Network settings to connect 

For this connection, you will 
router allows you to access the internet wirelessly on your device. 
computer and the loom will be connected to the same network. 
use this connection type, you must have access to the internet.

If you don’t have internet, you can still connect via WiFi with LoomDirect 
connection covered in its own

1) Connect your device to the loom via USB or LoomDirect.

2) Go to Network tab in AVL Drive

3) Select your network from the dropdown list and enter the password 
for your router.  

Note: 
The network light should remain RED during these steps. If your network light 
turns GREEN, you’ve entered the incorrect password for your router. 
the password for your router and reenter the correct password

4) Click the Restart Network button

Dobby V User’s Manual Connecting to the Loom

 

Once you establish the LoomDirect connection you won’t have to go 
through this process again. You can shut down your loom and you’ll 
be able to turn the loom on and connect to AVL Drive automatically. 

If you switch to a new device, you will need to connect to LoomDirect 
and enter the Network ID and password. 

Setting up Network settings to connect via LAN (Local Area Network)

For this connection, you will connect using your router at your location
router allows you to access the internet wirelessly on your device. 
computer and the loom will be connected to the same network. 
use this connection type, you must have access to the internet. 

If you don’t have internet, you can still connect via WiFi with LoomDirect 
its own section. 

Connect your device to the loom via USB or LoomDirect.

Go to Network tab in AVL Drive. 

network from the dropdown list and enter the password 
 

The network light should remain RED during these steps. If your network light 
GREEN, you’ve entered the incorrect password for your router. 

the password for your router and reenter the correct password.

Restart Network button.  
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ction you won’t have to go 
through this process again. You can shut down your loom and you’ll 
be able to turn the loom on and connect to AVL Drive automatically.  

If you switch to a new device, you will need to connect to LoomDirect on the 

via LAN (Local Area Network) 

location. The 
router allows you to access the internet wirelessly on your device. Both your 
computer and the loom will be connected to the same network. In order to 

 

If you don’t have internet, you can still connect via WiFi with LoomDirect 

Connect your device to the loom via USB or LoomDirect. 

 

network from the dropdown list and enter the password 

The network light should remain RED during these steps. If your network light 
GREEN, you’ve entered the incorrect password for your router. Check 

. 
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5) Unplug the USB or disconnect from LoomDirect.

6) Wait for the WiFi connection to the loom. It can take 
minutes for the loom to connect to the router.

7) The COM light will turn off during this period. When the COM light 
turns green, you’ll know connectio

8) Connect your device (laptop, tablet, phone) to the 
network you connected the loom to. 

9) You can refresh your browser. 

10) Once you establish
through this process again. You can 
be able to turn the loom on and connect to AVL Drive without these 
steps.  

Note:  
If your router name or password changes, you will have to setup the network 
using the USB or LoomDirect
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or disconnect from LoomDirect. 

for the WiFi connection to the loom. It can take up to several 
for the loom to connect to the router. 

The COM light will turn off during this period. When the COM light 
turns green, you’ll know connection has been reestablished.

Connect your device (laptop, tablet, phone) to the same 
network you connected the loom to.  

 

ou can refresh your browser.  

Once you establish the LAN WiFI connection you won’t have to go 
through this process again. You can shutdown your loom and you’ll 
be able to turn the loom on and connect to AVL Drive without these 

If your router name or password changes, you will have to setup the network 
using the USB or LoomDirect. 
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up to several 

The COM light will turn off during this period. When the COM light 
n has been reestablished. 

same WiFi 

LAN WiFI connection you won’t have to go 
hutdown your loom and you’ll 

be able to turn the loom on and connect to AVL Drive without these 

If your router name or password changes, you will have to setup the network 
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NAMING YOUR LOOM

Install Bonjour Print Services for Windows

Bonjour Print Services for Windows lets you access AVL Drive via your web 
browser using your "loom name" as the URL. Example: http://[loom 
name].local. This service needs to be downloaded and installed on your 
computer.  

1) Go to https://support.apple.com/kb/DL999?locale=en_US

2) Click the Download button.
on your computer. For Windows computers, this will most often be 
the Download folder.

Note: 
Depending on your browser, you will see a notice that the file is being 
downloaded at either the top or bottom of the scr
complete, you may be able to click on the notification to open and install the 
software. 
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OOM 

Print Services for Windows 

Bonjour Print Services for Windows lets you access AVL Drive via your web 
browser using your "loom name" as the URL. Example: http://[loom 

This service needs to be downloaded and installed on your 

https://support.apple.com/kb/DL999?locale=en_US. 

Click the Download button. The file will be downloaded to a location 
on your computer. For Windows computers, this will most often be 
the Download folder. 

Depending on your browser, you will see a notice that the file is being 
downloaded at either the top or bottom of the screen. Once the download is 
complete, you may be able to click on the notification to open and install the 
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Bonjour Print Services for Windows lets you access AVL Drive via your web 
browser using your "loom name" as the URL. Example: http://[loom 

This service needs to be downloaded and installed on your 

 

The file will be downloaded to a location 
on your computer. For Windows computers, this will most often be 

Depending on your browser, you will see a notice that the file is being 
een. Once the download is 

complete, you may be able to click on the notification to open and install the 
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3) Navigate to the correct folder.

4) Open the downloaded file to initiate the install wizard.

Add Loom Name 

Naming your loom is an important
loom via WiFi from any device. 

This creates a URL that you type in to the address bar on a web browser. It 
will be easy to remember, unlike the IP address. Your loom name can be 
changed at any time. 

The LOOM URL will be http:// + [loom name] + .local

 Compu-Dobby V User’s Manual
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Navigate to the correct folder. 

Open the downloaded file to initiate the install wizard. 

 

Naming your loom is an important step that will make it easy to access your 
loom via WiFi from any device.  

This creates a URL that you type in to the address bar on a web browser. It 
will be easy to remember, unlike the IP address. Your loom name can be 

http:// + [loom name] + .local 
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step that will make it easy to access your 

This creates a URL that you type in to the address bar on a web browser. It 
will be easy to remember, unlike the IP address. Your loom name can be 
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Example:  

Loom name = myloom 

Loom URL = http://myloom.local

Note: 
The name must be a solid piece of text with no spaces. If a space is added to 
the name, the URL will only be the letters before the space even
“Loom Name” shows the complete name with the space.

GOOD EXAMPLES: myloom, my_loom, my

BAD EXAMPLES: my loom (loom would only show up as “my”)

Note: 
If you ever forget the name of your loom you can always connect with the IP 
address. 

1) Once you have AVL Drive open, select the “Options” tab. 

 

2) In the box for Loom Name, enter the name you’d like to use for 
your loom. If the box is not blank, delete the existing name and 
enter the new text of your choice.

3) Click the enter button on your keyboa
anywhere on the page.

4) Refresh or exit your browser. 
then back on pretty quickly. 
loom name has been changed. You will also see the Connected To: 
field under Please se

Dobby V User’s Manual Connecting to the Loom

 

Loom URL = http://myloom.local 

The name must be a solid piece of text with no spaces. If a space is added to 
the name, the URL will only be the letters before the space even
“Loom Name” shows the complete name with the space. 

GOOD EXAMPLES: myloom, my_loom, my-loom 

BAD EXAMPLES: my loom (loom would only show up as “my”) 

If you ever forget the name of your loom you can always connect with the IP 

you have AVL Drive open, select the “Options” tab. 

In the box for Loom Name, enter the name you’d like to use for 
your loom. If the box is not blank, delete the existing name and 
enter the new text of your choice. 

Click the enter button on your keyboard, or simply clicking 
anywhere on the page.  

Refresh or exit your browser. The COM light will turn off and 
then back on pretty quickly. In the Options Tab you’ll see the 
loom name has been changed. You will also see the Connected To: 
field under Please select file has changed. 
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The name must be a solid piece of text with no spaces. If a space is added to 
the name, the URL will only be the letters before the space even though the 

If you ever forget the name of your loom you can always connect with the IP 

you have AVL Drive open, select the “Options” tab.  

 

In the box for Loom Name, enter the name you’d like to use for 
your loom. If the box is not blank, delete the existing name and 

y clicking 

The COM light will turn off and 
In the Options Tab you’ll see the 

loom name has been changed. You will also see the Connected To: 
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5) Type the new URL into your browser with your new Loom Name as 
shown in the beginning of this section
.local  

6) Click Enter on the keyboard

7) AVL Drive will refresh and the COM Light will light up once 
communication is established with the loom. You can now use this 
URL to access AVL Drive via USB, LAN, and LoomDirect. 

USING THE RESET FUNCTION

If at any time you see the below alert, you’ll need
reestablish connection to the loom. This could occur if you accidentally 
unplug your USB cable, or if you’re trying to connect a new device to the 
loom when another device is already connected. 

1) When connecting to the loom, you re

2) Enter “/reset” after the URL or IP address in your web browser. 

3) Refresh your page. 

4) Once you receive the notification that the “current use
logged out”, simply reenter your normal URL or IP address. 

 Compu-Dobby V User’s Manual

 Using the Reset Function

Type the new URL into your browser with your new Loom Name as 
shown in the beginning of this section: http:// + [loom name] + 

Click Enter on the keyboard. 

AVL Drive will refresh and the COM Light will light up once 
communication is established with the loom. You can now use this 
URL to access AVL Drive via USB, LAN, and LoomDirect. 

UNCTION 

If at any time you see the below alert, you’ll need to reset the web URL to 
reestablish connection to the loom. This could occur if you accidentally 
unplug your USB cable, or if you’re trying to connect a new device to the 
loom when another device is already connected.  

When connecting to the loom, you receive the message below.

 

Enter “/reset” after the URL or IP address in your web browser. 

Refresh your page.  

Once you receive the notification that the “current user
logged out”, simply reenter your normal URL or IP address. 

Dobby V User’s Manual 

Using the Reset Function 

Type the new URL into your browser with your new Loom Name as 
+ [loom name] + 

AVL Drive will refresh and the COM Light will light up once 
communication is established with the loom. You can now use this 
URL to access AVL Drive via USB, LAN, and LoomDirect.  

to reset the web URL to 
reestablish connection to the loom. This could occur if you accidentally 
unplug your USB cable, or if you’re trying to connect a new device to the 

ceive the message below. 

Enter “/reset” after the URL or IP address in your web browser.  

 

r has been 
logged out”, simply reenter your normal URL or IP address.  
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SHUTDOWN THE LOO

If you will be removing the loom from a power source, you will need to 
shutdown the loom using the commands in the software first. This is similar 
to shutting down a computer so that it restarts correctly.

1) In the software, go to the 

2) Click Shutdown. 

3) Once the loom has completed the shutdown sequence, you can 
remove power from the loom.

USING WEAVEPOINT

Weavepoint 8.0.2.0 and above offers direct access to AVL Drive for your 
loom with Compu-Dobby V. The loom control function in Weavepoint
open the software, and upload the pattern you have open in Weavepoint. 

Set Weave Options in WeavePoint

1) Select Options on the Weave menu to open the Weave Options 
dialogue box.  

2) Select Compu-Dobby V.  

Dobby V User’s Manual Connecting to the Loom

 

HUTDOWN THE LOOM 

If you will be removing the loom from a power source, you will need to 
shutdown the loom using the commands in the software first. This is similar 
to shutting down a computer so that it restarts correctly. 

In the software, go to the Utilities tab. 

 

Once the loom has completed the shutdown sequence, you can 
remove power from the loom. 

EAVEPOINT 

Weavepoint 8.0.2.0 and above offers direct access to AVL Drive for your 
Dobby V. The loom control function in Weavepoint

open the software, and upload the pattern you have open in Weavepoint. 

Set Weave Options in WeavePoint 

Select Options on the Weave menu to open the Weave Options 

 

Dobby V.   
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If you will be removing the loom from a power source, you will need to 
shutdown the loom using the commands in the software first. This is similar 

Once the loom has completed the shutdown sequence, you can 

Weavepoint 8.0.2.0 and above offers direct access to AVL Drive for your 
Dobby V. The loom control function in Weavepoint will 

open the software, and upload the pattern you have open in Weavepoint.  

Select Options on the Weave menu to open the Weave Options 
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Note: 
Compu-Dobby V will launch the AVL 
pattern you have open. If this is selected, there will be no other options you 
can choose in Weave Options window.

Connect to Loom 

1) Have the pattern you want to weave with open. You can use 
WeavePoint files or WIF f

2) Select Loom Control on the Weave menu.

3) Select USB if your loom is connected with a USB cable. If you are 
connecting to your loom

4) If WiFi is chosen, you must enter the Loom Address so that the 
connection will be made correct

Note:  
You may use either the IP Address or the Loom Name for the Compu
V. 

5) If you have a pattern open in WeavePoint, the pattern name will 
display here. 

 Compu-Dobby V User’s Manual

 Using Weavepoint

Dobby V will launch the AVL software that controls the loom with the 
pattern you have open. If this is selected, there will be no other options you 
can choose in Weave Options window. 

Have the pattern you want to weave with open. You can use 
WeavePoint files or WIF files. 

Select Loom Control on the Weave menu. 

Select USB if your loom is connected with a USB cable. If you are 
connecting to your loom wirelessly, choose WiFi. 

If WiFi is chosen, you must enter the Loom Address so that the 
connection will be made correctly. 

You may use either the IP Address or the Loom Name for the Compu

If you have a pattern open in WeavePoint, the pattern name will 
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Using Weavepoint 

software that controls the loom with the 
pattern you have open. If this is selected, there will be no other options you 

Have the pattern you want to weave with open. You can use 

 

Select USB if your loom is connected with a USB cable. If you are 

If WiFi is chosen, you must enter the Loom Address so that the 

You may use either the IP Address or the Loom Name for the Compu-Dobby 

If you have a pattern open in WeavePoint, the pattern name will 
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Using Weavepoint 

6) Select Replace any existing pattern with same name 
overwrite a pattern already

7) If Start loom control with this pattern 
open in the loom control so that it is ready for you to weave with.

8) Click OK. A message that the pattern was uploaded will appear.

9) Click OK. The pattern
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Replace any existing pattern with same name if you want to 
overwrite a pattern already on the loom with the same name.

Start loom control with this pattern is checked, the pattern will 
open in the loom control so that it is ready for you to weave with.

Click OK. A message that the pattern was uploaded will appear.

 

Click OK. The pattern will open in AVL Drive in the Weaving tab.
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if you want to 
the same name. 

is checked, the pattern will 
open in the loom control so that it is ready for you to weave with. 

Click OK. A message that the pattern was uploaded will appear. 

will open in AVL Drive in the Weaving tab. 
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No matter how you are connecting to the loom, the loom software will 
appear in your browser. Depending on the browser you are using, 
software may appear subtly different from the pictures in this manual, 
however all functionality will be the same.

WARPING THE LOOM

Looms with automatic warp tension motors are designed to allow you to 
wind on the warp without removing the tension cabl
Weaving tab allows you to set the tension to the lowest setting. 

1) Connect to the loom as described previous
to the File tab. 

2) Open the Weaving tab
open. 

3) Click Power On to boot up the loom. 

4) The button will switch to 
Power light on the interface 
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 Warping the Loom

No matter how you are connecting to the loom, the loom software will 
appear in your browser. Depending on the browser you are using, 
software may appear subtly different from the pictures in this manual, 
however all functionality will be the same. 

OOM 

Looms with automatic warp tension motors are designed to allow you to 
wind on the warp without removing the tension cable. A button 

you to set the tension to the lowest setting. 

Connect to the loom as described previously. The software defaults 

Open the Weaving tab. You do not need to have a weaving file 

Click Power On to boot up the loom.  

 

The button will switch to Power Off once the loom is ready and the 
Power light on the interface will turn red.  
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Warping the Loom 

No matter how you are connecting to the loom, the loom software will 
appear in your browser. Depending on the browser you are using, the 
software may appear subtly different from the pictures in this manual, 

Looms with automatic warp tension motors are designed to allow you to 
 on the 

you to set the tension to the lowest setting.  

The software defaults 

You do not need to have a weaving file 

once the loom is ready and the 
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Warping the Loom 

5) Click the free warp tension button.

6) The button will turn red to indicate it is activated. 
again to turn it off.

7) Wind the warp onto the warp beam. For more information, see the 
weaving section in your loom manual.

8) You can click Power Off to return 
threading the heddles and reed. If you are going to turn off p
to the loom, shutdown the loom through the software.
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warp tension button. 

 

The button will turn red to indicate it is activated. Click t
again to turn it off. 

 

Wind the warp onto the warp beam. For more information, see the 
weaving section in your loom manual. 

You can click Power Off to return the loom to standby when 
threading the heddles and reed. If you are going to turn off p
to the loom, shutdown the loom through the software. 
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Click the button 

Wind the warp onto the warp beam. For more information, see the 

to standby when 
threading the heddles and reed. If you are going to turn off power 
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STARTING TO WEAVE

1) Connect to the loom as described previously. The software defaults 
to the File tab. For complete information on the Files tab, including 
how to import files, see page 

2) Click a file from the list to select it.

3) Click Open for Weaving. The Weaving tab will open with your 
selected file as shown in the next screenshot
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 Starting to Weave

EAVE 

Connect to the loom as described previously. The software defaults 
For complete information on the Files tab, including 

how to import files, see page 42. 

Click a file from the list to select it. 

Click Open for Weaving. The Weaving tab will open with your 
as shown in the next screenshot. 
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Starting to Weave 

Connect to the loom as described previously. The software defaults 
For complete information on the Files tab, including 

 

Click Open for Weaving. The Weaving tab will open with your 
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Starting to Weave 

Power On 

When the loom is powered
motors engage and go to whichever setting the loom was shutdown in. 
 
The Power button is used to turn weaving mode on/off. It is not used to 
completely Shutdown the loom. Shutting down
utilities tab and is only needed when preparing the loom to be unplugged 
form power.  

1) Click Power On to boot up the loom. 

2) The button will switch to 
Power light on the interface wil
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powered on, the Power light goes to dark red. All the 
motors engage and go to whichever setting the loom was shutdown in. 

The Power button is used to turn weaving mode on/off. It is not used to 
completely Shutdown the loom. Shutting down the loom is done through the 
utilities tab and is only needed when preparing the loom to be unplugged 

Click Power On to boot up the loom.  

 

The button will switch to Power Off once the loom is ready
Power light on the interface will turn red.  
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on, the Power light goes to dark red. All the 
motors engage and go to whichever setting the loom was shutdown in.  

The Power button is used to turn weaving mode on/off. It is not used to 
the loom is done through the 

utilities tab and is only needed when preparing the loom to be unplugged 

once the loom is ready and the 
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3) Once the loom is ready, begin to weave.

Note: 
If you are resuming a weaving session, the loom will remember the cloth 
advance and tension settings. With most versions of the software, you will be 
asked if you want to resume weaving where yo

CONTROLLING THE 

The cloth advance controls allow you to advance the warp without weaving, 
or reverse the warp. You can also set the picks per inch (PPI). The default 
PPI is 15. 

Advance the Warp 

Typically, you manually advance forward to bring the fell line to the correct 
weaving position after you have warped the loom
when the beater arms hit the bumpers and the fell line is at the reed.

1) In the software go to the Cloth Advance area. 

2) Use the up arrow to advance the warp. Click the arrow until the 
warp has advanced as far as you want it.

Set the PPI 
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 Controlling the Cloth Advance

Once the loom is ready, begin to weave. 

If you are resuming a weaving session, the loom will remember the cloth 
advance and tension settings. With most versions of the software, you will be 
asked if you want to resume weaving where you left off in the pattern.

ONTROLLING THE CLOTH ADVANCE 

The cloth advance controls allow you to advance the warp without weaving, 
or reverse the warp. You can also set the picks per inch (PPI). The default 

ly advance forward to bring the fell line to the correct 
after you have warped the loom. The correct position is 

when the beater arms hit the bumpers and the fell line is at the reed.

In the software go to the Cloth Advance area.  

 

arrow to advance the warp. Click the arrow until the 
warp has advanced as far as you want it. 
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Controlling the Cloth Advance 

If you are resuming a weaving session, the loom will remember the cloth 
advance and tension settings. With most versions of the software, you will be 

u left off in the pattern. 

The cloth advance controls allow you to advance the warp without weaving, 
or reverse the warp. You can also set the picks per inch (PPI). The default 

ly advance forward to bring the fell line to the correct 
. The correct position is 

when the beater arms hit the bumpers and the fell line is at the reed. 

 

arrow to advance the warp. Click the arrow until the 
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Set Warp Tension 

The default for the cloth advance is picks per inch, but you can change 
inches to centimeters in the options tab.

It’s important to note that PPI can be affected by types of yarn and the sett, 
so please use the PPI as indicated in the Cloth Advance Box as a starting 
point, and understand that numbers may need to be adjusted to get the 
correct PPI on the cloth. However, once you have the PPI s
change on the cloth until adjusted in the software.

1) In the software go to the Cloth Advance area and click in the 
field.  

2) Use the small arrow keys to change the value, or click in the field 
and type in the value you want.

Note: 
If you want to advance the warp quickly, for example when warping the loom, 
set the PPI to one. 

SET WARP TENSION

You can set the tension by entering a number in the field or by using the up 
and down arrows on the field. The default tension is set at 55.

When the loom is powered on for weaving, the warp tension motor will 
search for its reference home, then return to the tension setting left by the 
weaver in the previous weaving session.

1) In the software go to the 
change the value, or click in the field and type in the value you 
want. 
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The default for the cloth advance is picks per inch, but you can change 
inches to centimeters in the options tab. 

at PPI can be affected by types of yarn and the sett, 
so please use the PPI as indicated in the Cloth Advance Box as a starting 
point, and understand that numbers may need to be adjusted to get the 
correct PPI on the cloth. However, once you have the PPI set, it will not 
change on the cloth until adjusted in the software. 

In the software go to the Cloth Advance area and click in the 

 

Use the small arrow keys to change the value, or click in the field 
and type in the value you want. 

you want to advance the warp quickly, for example when warping the loom, 

ENSION 

You can set the tension by entering a number in the field or by using the up 
and down arrows on the field. The default tension is set at 55. 

loom is powered on for weaving, the warp tension motor will 
search for its reference home, then return to the tension setting left by the 
weaver in the previous weaving session. 

In the software go to the Warp Tension field. Use the arrow keys to 
ge the value, or click in the field and type in the value you 
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The default for the cloth advance is picks per inch, but you can change 

at PPI can be affected by types of yarn and the sett, 
so please use the PPI as indicated in the Cloth Advance Box as a starting 
point, and understand that numbers may need to be adjusted to get the 

et, it will not 

In the software go to the Cloth Advance area and click in the PPI 

Use the small arrow keys to change the value, or click in the field 

you want to advance the warp quickly, for example when warping the loom, 

You can set the tension by entering a number in the field or by using the up 

loom is powered on for weaving, the warp tension motor will 
search for its reference home, then return to the tension setting left by the 

. Use the arrow keys to 
ge the value, or click in the field and type in the value you 
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TABBY 

You may want to weave a tabby header before beginning your main pattern. 
The tabby tab allows you to choose the pattern that will create plain weave 
with the threading you are us
on the Tabby tab, you will be able to switch to it at any point by clicking the 
Tabby button on the Weaving tab. For information on how to setup new 
tabbies, please see page 51

1) Open the Tabby Tab by clicking on the name. The tabby will only 
show the number of shafts available on your loom.
example was taken on a 40 shaft loom.

2) From the drop-down menu, choose
threading. Several defaults are available.
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You may want to weave a tabby header before beginning your main pattern. 
The tabby tab allows you to choose the pattern that will create plain weave 
with the threading you are using. Once you have chosen the correct tabby 
on the Tabby tab, you will be able to switch to it at any point by clicking the 
Tabby button on the Weaving tab. For information on how to setup new 

51. 

Open the Tabby Tab by clicking on the name. The tabby will only 
show the number of shafts available on your loom. The following 
example was taken on a 40 shaft loom. 

down menu, choose the tabby to use with your 
threading. Several defaults are available. 
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 Tabby 

You may want to weave a tabby header before beginning your main pattern. 
The tabby tab allows you to choose the pattern that will create plain weave 

ing. Once you have chosen the correct tabby 
on the Tabby tab, you will be able to switch to it at any point by clicking the 
Tabby button on the Weaving tab. For information on how to setup new 

Open the Tabby Tab by clicking on the name. The tabby will only 
The following 

 

the tabby to use with your 
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Tabby 

3) Return to the weaving tab.

4) Click Tabby to switch to the pre
on the weaving tab will change to plain weave and the button will 
change from Tabby to Pattern with red text.

Note: 
If the pattern that is showing is not plain weave, you may have chosen the 
wrong tabby. Return to the tabby tab and cha
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Return to the weaving tab. 

 

Click Tabby to switch to the pre-defined tabby. The pattern showing 
on the weaving tab will change to plain weave and the button will 
change from Tabby to Pattern with red text. 

If the pattern that is showing is not plain weave, you may have chosen the 
wrong tabby. Return to the tabby tab and change the tabby. 
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The pattern showing 
on the weaving tab will change to plain weave and the button will 

If the pattern that is showing is not plain weave, you may have chosen the 
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5) To return to the pattern, click the Pattern button.

REVERSE 

The Reverse feature flips the pattern upside down and keeps you weaving 
forward. This is NOT used to unweave or to go backwards in your pattern.

This could be used to provide symm
the ends of a scarf the same when it is worn.

1) Click Reverse to reverse the weaving pattern. This allows you to 
automatically reverse the weaving order of the WIF.
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To return to the pattern, click the Pattern button. 

The Reverse feature flips the pattern upside down and keeps you weaving 
forward. This is NOT used to unweave or to go backwards in your pattern.

provide symmetry in a pattern, for example,
the ends of a scarf the same when it is worn. 

Click Reverse to reverse the weaving pattern. This allows you to 
automatically reverse the weaving order of the WIF. 
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 Reverse 

 

The Reverse feature flips the pattern upside down and keeps you weaving 
forward. This is NOT used to unweave or to go backwards in your pattern. 

etry in a pattern, for example, keeping 

Click Reverse to reverse the weaving pattern. This allows you to 
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Set the Range 

2) The button will change to Forward with red text. Click Forward to 
return to the original pattern.

SET THE RANGE 

If you do not want to weave the whole pattern, enter the range of picks you 
want to use. Once you reach the end of the range, the range will r
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The button will change to Forward with red text. Click Forward to 
return to the original pattern. 

If you do not want to weave the whole pattern, enter the range of picks you 
Once you reach the end of the range, the range will r
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The button will change to Forward with red text. Click Forward to 

 

If you do not want to weave the whole pattern, enter the range of picks you 
Once you reach the end of the range, the range will repeat.  
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Use this feature to experiment with different looks from the same WIF file.
You could also choose a small section from a longer pattern to help create a 
set of differing sized items, for example, a table runner and napkins.

1) In the Set Range Area, 

2) The Set Range window appears.

3) Enter the Start and End Picks. Click Apply.

The following examples show the full pattern, then
set as the range for the same WIF file
different. 
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Use this feature to experiment with different looks from the same WIF file.
You could also choose a small section from a longer pattern to help create a 
set of differing sized items, for example, a table runner and napkins.

In the Set Range Area, click Set Range. 

 

The Set Range window appears. 

 

Enter the Start and End Picks. Click Apply. 

show the full pattern, then 1-10 and then 1
for the same WIF file. Each pattern appears slightly
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 Set the Range 

Use this feature to experiment with different looks from the same WIF file. 
You could also choose a small section from a longer pattern to help create a 
set of differing sized items, for example, a table runner and napkins. 

10 and then 1-15 were 
slightly 
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Set the Range 
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UNWEAVE 

WARNING:  
Anytime you move the weaving backwards, you must remove the pin in the 
cloth storage beam. This will release the tension on your finished cloth so 
that the loom will not be damaged.

The Unweave button is used when you need to remove som
threads. When you press down the treadle, the shed will open the picks in 
the reverse order that you wove. 
Unweave is selected. Once you have removed the weft back to the desired 
point, you can use the manual advance buttons in the cloth advance section 
of the Weaving tab to adjust your fell line back to the proper point if 
necessary. 

1) Take the pin out of the cloth advance beam so that the cloth will 
unwind easily. 
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weaving backwards, you must remove the pin in the 
cloth storage beam. This will release the tension on your finished cloth so 
that the loom will not be damaged. 

The Unweave button is used when you need to remove some of your weft 
threads. When you press down the treadle, the shed will open the picks in 
the reverse order that you wove. The warp beam will move backwards when 

Once you have removed the weft back to the desired 
manual advance buttons in the cloth advance section 

of the Weaving tab to adjust your fell line back to the proper point if 

Take the pin out of the cloth advance beam so that the cloth will 
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 Unweave 

 

weaving backwards, you must remove the pin in the 
cloth storage beam. This will release the tension on your finished cloth so 

e of your weft 
threads. When you press down the treadle, the shed will open the picks in 

The warp beam will move backwards when 
Once you have removed the weft back to the desired 

manual advance buttons in the cloth advance section 
of the Weaving tab to adjust your fell line back to the proper point if 

Take the pin out of the cloth advance beam so that the cloth will 
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Unweave 

2) Click Unweave. 

3) The button will chan
return to normal functionality.

Reverse the Warp 

1) Make sure the pin is out of the cloth advance beam so that the cloth 
will unwind easily

2) In the software go to the Cloth Advance area. 

3) Use the down arrow to rever
warp has reversed
the fell line. 

4) Reset the tension. Depending on how far you have unwoven, you 
may need to rewind the warp onto the warp beam.
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The button will change to Weave with red text. Click Weave to 
return to normal functionality. 

Make sure the pin is out of the cloth advance beam so that the cloth 
will unwind easily 

In the software go to the Cloth Advance area.  

 

arrow to reverse the warp. Click the arrow until the 
reversed as far as you want it. Use the beater to adjust 

Reset the tension. Depending on how far you have unwoven, you 
may need to rewind the warp onto the warp beam. 
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ge to Weave with red text. Click Weave to 

Make sure the pin is out of the cloth advance beam so that the cloth 

se the warp. Click the arrow until the 
Use the beater to adjust 

Reset the tension. Depending on how far you have unwoven, you 
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5) Return the pin to the 

Note: 
If you cannot find the hole for the pin easily, move the cloth advance beam by 
using the beater until you see the hole. The cloth advance beam will not wind 
on cloth unless the pin is in the hole.

6) If there is any slack in the 
beater. 

Set the Pick 

Most versions of the Compu
resume where you left off at your last weaving session. If you have an older 
version, it may not save your last pick. In this
to start this weaving session with.

You can also use this feature to start at a different pick then the one you left 
off at for design purposes.

Note: 
Check the current pick to see what will be opened when you treadle. If the
current pick is zero, treadle once to advance to the correct pick.

1) In the Pick area, click Set Pick.

2) The Set Pick window appears.

3) Enter the pick you want to start with and click Apply.
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Return the pin to the cloth advance beam. 

If you cannot find the hole for the pin easily, move the cloth advance beam by 
using the beater until you see the hole. The cloth advance beam will not wind 
on cloth unless the pin is in the hole. 

If there is any slack in the cloth you can tighten up by using the 

Most versions of the Compu-Dobby V software will ask you if you want to 
resume where you left off at your last weaving session. If you have an older 
version, it may not save your last pick. In this case, enter the pick you want 
to start this weaving session with. 

You can also use this feature to start at a different pick then the one you left 
off at for design purposes. 

heck the current pick to see what will be opened when you treadle. If the
current pick is zero, treadle once to advance to the correct pick.

In the Pick area, click Set Pick. 

 

The Set Pick window appears. 

 

Enter the pick you want to start with and click Apply. 
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 Unweave 

If you cannot find the hole for the pin easily, move the cloth advance beam by 
using the beater until you see the hole. The cloth advance beam will not wind 

cloth you can tighten up by using the 

Dobby V software will ask you if you want to 
resume where you left off at your last weaving session. If you have an older 

, enter the pick you want 

You can also use this feature to start at a different pick then the one you left 

heck the current pick to see what will be opened when you treadle. If the 
current pick is zero, treadle once to advance to the correct pick. 
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Unweave 

Zoom in on the WIF 

You can zoom in on the WIF in order to see it 
out on the WIF in order to see more of it.

1) Click the + or – zoom buttons until you have adjusted the view of 
the WIF file to what you want.

The following examples show a weaving tab that is zoomed out, and then 
one that shows it zoomed in.

Dobby V User’s Manual Weaving with the Compu

 

You can zoom in on the WIF in order to see it in more detail. You can zoom 
out on the WIF in order to see more of it. 

zoom buttons until you have adjusted the view of 
the WIF file to what you want. 

 

The following examples show a weaving tab that is zoomed out, and then 
ws it zoomed in. 

e Compu-Dobby V 

 Page | 37 

in more detail. You can zoom 

zoom buttons until you have adjusted the view of 

The following examples show a weaving tab that is zoomed out, and then 
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Lock the warp beam 

There is a button that allows you to lock the warp beam in place. When the 
warp beam is locked, the cloth

This feature could be used by weavers who want to be able to experiment 
with placing wefts while manually advancing the cloth and letting off warp. 

If you need to treadle through your pattern for some reason, you can use 
this feature to avoid having the warp advance.

You can also turn off the cloth advance without locking the wa
page 45. 

1) Open the software. 

2) Click the Lock wrap beam button.

3) Click the button again to turn it off.
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There is a button that allows you to lock the warp beam in place. When the 
cloth advance is automatically disabled.

be used by weavers who want to be able to experiment 
h placing wefts while manually advancing the cloth and letting off warp. 

If you need to treadle through your pattern for some reason, you can use 
this feature to avoid having the warp advance. 

You can also turn off the cloth advance without locking the warp beam. See 

Open the software.  

Click the Lock wrap beam button. 

 

Click the button again to turn it off. 
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There is a button that allows you to lock the warp beam in place. When the 
advance is automatically disabled. 

be used by weavers who want to be able to experiment 
h placing wefts while manually advancing the cloth and letting off warp.  

If you need to treadle through your pattern for some reason, you can use 

rp beam. See 
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Unweave 

 

Power Off 

1) When you are done weaving, click 
its normal standby state. If you are going to turn off power to the 
loom, shutdown the loom through the software.

Dobby V User’s Manual Weaving with the Compu

 

 

When you are done weaving, click Power Off to return the loom to 
its normal standby state. If you are going to turn off power to the 
loom, shutdown the loom through the software. 

 

Weaving with the Compu-Dobby V 
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Power Off to return the loom to 
its normal standby state. If you are going to turn off power to the 
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OTHER TABS 
OTHER TABS 

LOOM SOFTWARE 
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FILE TAB 

Files are stored on the loom. The files must be 
tab allows you to open your weaving files or to transfer weaving files to the 
loom. It is the default tab that appears when you open the software.

If you are using Weavepoint, you can use the loom control feature to open 
Weavepoint files directly in AVL Drive. With any other software, you must 
export your weaving files to the WIF format. With the Compu
are stored directly on the loom. From the files tab, you can open WIF files 
that have been stored on the loom. You
computer to the loom for use.

Note: 
If no file is selected, only Transfer to Loom and Open, Upload to Loom, and 
Backup to Local Machine will be available.

Button 
Transfer to Loom and Open

Open for Weaving 

Rename 
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Files are stored on the loom. The files must be in the WIF format. The file 
tab allows you to open your weaving files or to transfer weaving files to the 
loom. It is the default tab that appears when you open the software.

If you are using Weavepoint, you can use the loom control feature to open 
int files directly in AVL Drive. With any other software, you must 

export your weaving files to the WIF format. With the Compu-Dobby 5, files 
are stored directly on the loom. From the files tab, you can open WIF files 
that have been stored on the loom. You can also upload files from your 
computer to the loom for use. 

If no file is selected, only Transfer to Loom and Open, Upload to Loom, and 
Backup to Local Machine will be available. 

What it does 
Transfer to Loom and Open Transfer a file from local storage to the loom 

and open it. Complete instructions follow.
Opens the selected file for weaving. You can 
also double-click a file to open it for weaving.
Rename a file. For example if you have 
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 File Tab 

in the WIF format. The file 
tab allows you to open your weaving files or to transfer weaving files to the 
loom. It is the default tab that appears when you open the software. 

If you are using Weavepoint, you can use the loom control feature to open 
int files directly in AVL Drive. With any other software, you must 

Dobby 5, files 
are stored directly on the loom. From the files tab, you can open WIF files 

can also upload files from your 

If no file is selected, only Transfer to Loom and Open, Upload to Loom, and 

 

from local storage to the loom 
. Complete instructions follow. 

Opens the selected file for weaving. You can 
click a file to open it for weaving. 

. For example if you have 
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File Tab 

Delete 

Upload to Loom 

Download from Loom 
Backup to Local Machine 
Transfer to Loom and Open

This option allows you to find 
to the loom storage system for use. The file will be transferred to and also 
opened in the Weaving tab for use.

1) Click Transfer to Loom and Open
for your device will appear.

2) Navigate to the folder
to use. 
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several files with similar names, you might 
rename the file you are actively using so that 
it is easy to find. 
Delete a file from the loom. While there are 
no limits on how many files can be stored, 
deleting files that are not being used can 
make it easier to find the files you want in the 
list. 
Transfer a file to the loom without opening it.
Complete instructions follow. 
For future use. 
For future use. 

Transfer to Loom and Open 

This option allows you to find WIF files on your computer and transfer them 
to the loom storage system for use. The file will be transferred to and also 
opened in the Weaving tab for use. 

Transfer to Loom and Open. The standard open file window 
for your device will appear. 

gate to the folder where you have stored the WIF file you want 
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lar names, you might 
rename the file you are actively using so that 

. While there are 
no limits on how many files can be stored, 

t being used can 
les you want in the 

Transfer a file to the loom without opening it. 

WIF files on your computer and transfer them 
to the loom storage system for use. The file will be transferred to and also 

The standard open file window 

 

where you have stored the WIF file you want 
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3) Choose the desired WIF file from the folder

4) Click Open. 

5) The WIF file will open in the Weaving Tab

Note: 
This process will upload the file to the loom, 
this WIF, you can choose it from the File tab.

Upload to Loom 

This option will transfer the WIF file to the loom for use in the future, but it 
will not be opened in the Weaving tab.

1) Click Upload to Loom
device will appear.

2) Navigate to the folder where you have stored the WIF file you want 
to use. 

3) Choose the desired WIF file from the folder

4) Click Open. 

5) The WIF file will appear in the list of files in the Files tab.
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Choose the desired WIF file from the folder by clicking on it

The WIF file will open in the Weaving Tab in AVL Drive.

This process will upload the file to the loom, so the next time you want to use 
this WIF, you can choose it from the File tab. 

This option will transfer the WIF file to the loom for use in the future, but it 
will not be opened in the Weaving tab. 

Upload to Loom. The standard open file window for your 
device will appear. 

Navigate to the folder where you have stored the WIF file you want 

Choose the desired WIF file from the folder by clicking on it

The WIF file will appear in the list of files in the Files tab.
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 File Tab 

by clicking on it. 

. 

so the next time you want to use 

This option will transfer the WIF file to the loom for use in the future, but it 

file window for your 

 

Navigate to the folder where you have stored the WIF file you want 

by clicking on it. 

The WIF file will appear in the list of files in the Files tab. 
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Options Tab 

OPTIONS TAB 

This tab allows you to set several options for your loom.

1) To activate an option, check the box.

2) To turn off an option, uncheck the box.

 
Loom Name 

The name of your loom. Changing the name will change the address you 
need to type to access your loom.
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This tab allows you to set several options for your loom. 

To activate an option, check the box. 

To turn off an option, uncheck the box. 

The name of your loom. Changing the name will change the address you 
our loom. See page 13 for complete instructions.
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The name of your loom. Changing the name will change the address you 
for complete instructions. 
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History Percent 

Move the percentage bar to indicate 
devoted to history. The following examples show a screen with less history 
and more history. 
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Move the percentage bar to indicate how much of the screen should be 
following examples show a screen with less history 
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 Options Tab 

how much of the screen should be 
following examples show a screen with less history 
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Options Tab 

Show repeat counter 

Shows the repeat number in the software.
screen with the repeat counter on and with it off.
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Shows the repeat number in the software. The following examples show the 
screen with the repeat counter on and with it off. 
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The following examples show the 
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Show color bar 

The color bar to the right of the draft will appear.
show the color bar on and the color bar off.
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to the right of the draft will appear. The following examples 
show the color bar on and the color bar off. 
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 Options Tab 

The following examples 
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Options Tab 

Show drawdown in color

Allows you to view the WIF in color.
color and the WIF with the color option tur
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Show drawdown in color 

Allows you to view the WIF in color. The following examples show the WIF in 
color and the WIF with the color option turned off. 
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The following examples show the WIF in 
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Show numbers in liftplan

When you are zoomed in far enough on the WIF, you will be able to see the 
harness numbers. The following example shows the WIF as it will appear if 
you zoomed out too far, or
color drawdown on the previous page show harness numbers.

Fabric scrolls down 

If selected the fabric will scroll down on the screen as you weave, if not, the 
fabric will scroll up. The following example shows this option turned on. The 
other screenshots in this manual show the fabric scrolling up.
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Show numbers in liftplan 

When you are zoomed in far enough on the WIF, you will be able to see the 
. The following example shows the WIF as it will appear if 

far, or if you turn this option off. The examples
color drawdown on the previous page show harness numbers. 

If selected the fabric will scroll down on the screen as you weave, if not, the 
The following example shows this option turned on. The 

eenshots in this manual show the fabric scrolling up. 
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 Options Tab 

When you are zoomed in far enough on the WIF, you will be able to see the 
. The following example shows the WIF as it will appear if 

The examples for the 

 

If selected the fabric will scroll down on the screen as you weave, if not, the 
The following example shows this option turned on. The 
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Tabby Tab 

Use metric (cm) for advance

This option allows you to use the metric system
default is imperial (inches).

Enable Cloth Beam Advance

This option allows you to turn on or off 

TABBY TAB 

This tab allows you to set up or use a tabby.
your threading requires a tabby pattern that is not included, you can add a 
new tabby. You can also edit, delete, or rename existing tabbies.

1) With the AVLDrive software

2) To select a tabby, choose it from the drop
that appears in the tab is the one that will be selected when the 
Tabby button is clicked on the Weaving tab.
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Use metric (cm) for advance 

llows you to use the metric system for the cloth advance
default is imperial (inches). 

Enable Cloth Beam Advance 

s you to turn on or off the cloth beam advance.

This tab allows you to set up or use a tabby. Several defaults are included. If 
your threading requires a tabby pattern that is not included, you can add a 
new tabby. You can also edit, delete, or rename existing tabbies.

AVLDrive software open, click Tabby. 

To select a tabby, choose it from the drop-down menu. The tabby 
that appears in the tab is the one that will be selected when the 
Tabby button is clicked on the Weaving tab. 

 Other Tabs 

 Page | 51 

for the cloth advance. The 

beam advance. 

Several defaults are included. If 
your threading requires a tabby pattern that is not included, you can add a 
new tabby. You can also edit, delete, or rename existing tabbies. 

 

down menu. The tabby 
that appears in the tab is the one that will be selected when the 



Other Tabs 

Page | 52 

Add a Tabby 

1) Click Add. 

2) Enter the name of the Tabby

3) Click OK. 
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the name of the Tabby. 
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 Tabby Tab 
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Tabby Tab 

Edit a Tabby 

1) Choose the Tabby from the drop

2) Click Edit. The background color of the tabby will change.

3) Click the harnesses that should rise on each lift.
A and the bottom line is pick B

4) When you are done, click Edit again.
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Choose the Tabby from the drop-down list. 

Click Edit. The background color of the tabby will change.

Click the harnesses that should rise on each lift. The top line is pick 
A and the bottom line is pick B. 

When you are done, click Edit again. 
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Click Edit. The background color of the tabby will change. 

 

The top line is pick 
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Delete a Tabby 

Note: 
The Odds and Evens tabby cannot be deleted.

1) Choose the Tabby from the drop

2) Click Delete. 

3) Click OK at the confirmation window.

Rename a Tabby 

1) Choose a Tabby from the drop

2) Click Rename. 

3) Enter the new name in the window and click OK.
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The Odds and Evens tabby cannot be deleted. 

Choose the Tabby from the drop-down list. 

 

Click OK at the confirmation window. 

Choose a Tabby from the drop-down list. 

 

Enter the new name in the window and click OK. 
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 Tabby Tab 
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Tabby Tab 

Use a Tabby 

When you change the tabby in the drop
that will be used by the loom when you click Tabby on the Weaving tab.

1) Open the Tabby Tab by clicking 
show the number of shafts available on your loom.

2) From the drop-down menu, choose the tabby to use with your 
threading. Several defaults are available.
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When you change the tabby in the drop-down menu, you change the tabby 
that will be used by the loom when you click Tabby on the Weaving tab.

Open the Tabby Tab by clicking on the name. The tabby will only 
show the number of shafts available on your loom. 

down menu, choose the tabby to use with your 
threading. Several defaults are available. 
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down menu, you change the tabby 
that will be used by the loom when you click Tabby on the Weaving tab. 

on the name. The tabby will only 

 

down menu, choose the tabby to use with your 
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UTILITIES 

This tab allows you to perform several operations for yo

 
Button What it does
Check for update Checks to see if there are updates for the loom 

software. The loom must be connected to the 
internet.

Fetch configuration Gets configuration information for your software. 
The loom must be connected to the

Show Log Displays a log of software events. This can be sent 
to AVL for diagnostics if something is wrong with 
your loom.

Shutdown Shuts down the loom safely so that it can be 
removed from power.
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This tab allows you to perform several operations for your loom.

What it does 
Checks to see if there are updates for the loom 
software. The loom must be connected to the 
internet. 
Gets configuration information for your software. 
The loom must be connected to the internet.
Displays a log of software events. This can be sent 
to AVL for diagnostics if something is wrong with 
your loom. 
Shuts down the loom safely so that it can be 
removed from power. 
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 Utilities 

ur loom. 

 

Checks to see if there are updates for the loom 
software. The loom must be connected to the 

Gets configuration information for your software. 
internet. 

Displays a log of software events. This can be sent 
to AVL for diagnostics if something is wrong with 

Shuts down the loom safely so that it can be 
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Diagnostics 

DIAGNOSTICS 

This tab allows you to view 

 
 
 

ual 

 

This tab allows you to view information about your solenoids. 
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AVL CUSTOMER SERVICE 

AVL offers free technical support to the original owner of all our looms.This 
means if you ever have a problem, you can call, fax, or e-mail us and we’ll 
help you find a solution.Please take advantage of this service; your 
satisfaction is extremely important to us. 

Customer Service Phone: (530) 893-4915 
Fax:(530) 893-1372 

E-Mail:sales@avlusa.com 

AVL WARRANTIES 

Limited Warranty:The benefits of this warranty accrue solely to the original purchaser of AVL Looms, 
Inc. products, as defined below. 
 
Your warranty covers: 
 
New Looms: AVL Looms, Inc., a California corporation (“AVL”) warrants to the original purchaser of any 
AVL loom (each, a "Product") that the Product will be free from defects in materials and workmanship 
during the limited warranty period described herein. The limited warranty coverage begins (a) the day 
the Product is installed if installed by a professional from AVL, or (b) on the date of shipment from AVL 
to the original purchaser if the Product is not installed by AVL (the “Effective Date”). Except as set forth 
under the section entitled “What is Excluded?” below, AVL will, for a period of two (2) years from the 
Effective Date (the “Original Warranty Period”), repair or replace the defective part(s) of the Product with 
a repaired, renewed, or comparable part (whichever is deemed necessary or proper by AVL) if it 
becomes defective or inoperative or fails to perform according to AVL’s specifications. Any repair during 
the Original Warranty Period will be carried out without charge to you for parts (except applicable taxes, 
if any). You will be responsible for all labor in connection with installation of the parts and service upon 
the Product, as well as the cost of shipping involved. 

 
New Accessories, Loom Upgrade Parts, and Replacement Parts:Subject to the limitation contained in 
subsection (i) under the section entitled “What is Excluded?” below, AVL warrants to the original 
purchaser of any accessory, loom upgrade parts, or loom replacement parts (the “Additional Part”) that 
are sold by AVL that such Additional Part will be free from defects in materials and workmanship for 
ninety (90) days from the date of purchase. In the event that any Additional Part is physically damaged or 
physically defective and if such defective Additional Part is returned to AVL within ninety (90) days of the 
date of purchase, AVL will provide a replacement Additional Part at no charge. The sole remedy for this 
warranty shall be limited to the replacement of the defective Additional Part. You are responsible for all 
shipping charges (including applicable taxes) incurred with returning the defective Additional Part. 
 
All New Products and their components (including replacement Product and its components) are covered 
only for the Original Warranty Period. When the warranty on the original Product expires, the warranty on 
any replacement Product, or components also expires. After two (2) years from the Effective Date, you 
pay for any replacement or repair, including all parts, all labor and shipping charges (including applicable 
taxes). 
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Your warranty does not cover: 

1.Labor charges for installation or set-up of the Product, as well as any labor charges required to 
install, disassemble, troubleshoot, or reassemble the Product. 

2.Any taxes imposed on AVL for Product replacement or repair under this warranty. 

3.Installation, performance of, or repair of: cabling, electrical, or accessory attachments used with the 
Product. 

4.Product replacement or repair because of misuse, accident, repair by any party other than AVL, or 
other cause not within the control of AVL. Please note that removing any parts from the Product for any 
reason voids the warranty. 

5.Incidental or consequential damages resulting from the Product. 

6.A Product that has been modified or adapted to enable it to operate in any country other than the 
United States or any repair of Products damaged by these modifications. 

7.Electrical and pneumatic components, each of which carries a one (1) year warranty from the 
Effective Date. 

8.Jacquard components function beyond 98%. A Jacquard module is considered to be operating within 
specification if 98% of all hooks are operating as commanded. 

9.Computing equipment, such as a Personal Digital Assistant or a Personal Computer, which are 
manufactured by a third party(ies) and which may be under warranty through the original manufacturer. 
AVL is not responsible for any warranty coverage that may be offered concerning these products and 
you must contact those manufacturers directly regarding any available warranty coverage. 

The performance or functionality of any software that is sold either together or separate from the Product. 
The AVL warranty covers only defects in the Software Media, namely the CD-ROM media such as a 
broken CD-ROM or a defect in the CD-ROM that would prevent the CD-ROM from being read by your 
personal computer's CD-ROM drive.. 

AVL Returns Policy 

Any order that has left AVL in transit to the customer is considered fulfilled. 
Parts and accessories not covered under warranty must be returned to AVL 
within 60 days from the date of shipment from AVL. The purchase price of 
the item(s) is refundable less a 15% re-stocking fee based on the total 
purchase price. No refunds will be given on shipping or handling. The buyer 
is responsible to return the merchandise in "as new" condition at their 
expense. Any item received showing wear or damage is not eligible for 
return and will be promptly returned to the customer COD unless some other 
arrangement is made. Looms and custom-made items, special order items, 
parts made for pre-1998 looms, used and reconditioned items are not 
eligible for return.


